FORMS COMPOSITION FEATURES

ELECTRONIC BUSINESS FORMS

INTERNET BUSINESS FORMS

PAPER BUSINESS FORMS

Getting Started
OneForm™ Designer Plus
© 2010 by Amgraf, Inc. All rights reserved.
These specifications are subject to change without notice.

OneForm and MECCA are trademarks of Amgraf, Inc.
All other brand and product names are or may be trademarks used
to identify products or services of their respective owners.

AMGRAF
SOFTWARE TECHNOLOGY
1501 Oak Street • Kansas City, MO 64108-1424
Phone: (816) 474-4797 • Fax: (816) 842-4477
E-Mail: info@amgraf.com • Internet: www.amgraf.com
TABLE OF CONTENTS

Chapter 1: Overview and Installation
  Welcome to Amgraf’s OneForm Designer Plus ........ 1
  Key Features of OneForm Designer Plus ............ 2
  System Requirements .......................... 3
  About the Documentation ...................... 3
  Installing OneForm Designer Plus .............. 4
  Software Security Device Needed .............. 4
  Technical Support ........................... 5
  The Importance of Font Setup .................. 6
  OneForm Designer Plus Profile ................. 8

Chapter 2: Starting OneForm Designer Plus
  OneForm’s Main Window ...................... 10
  Opening a New File .......................... 11
  Select Cursor Controls ..................... 12
  Basic Drawing Tools ....................... 13
  Text Editor Tool ........................... 13
  Pop-Up Menus ................................ 14
  Saving a New File .......................... 15
  Quitting and Saving ......................... 16
  Opening a File From the Library ............. 17
  Opening an Existing Form .................... 18

Chapter 3: Tutorial - Drawing A New Form
  Setup New Drawing Properties ............... 21
  Turn On Grid ................................ 23
  Draw All Ruling First ....................... 23
  Set Line and Box Attributes ................. 24
  Draw Lines and Boxes ....................... 25
  Drawing Multiple Lines ..................... 26
  Place Text .................................. 27
  Modify Lines if Necessary .................. 27
  Modifying Text Properties .................. 28
  Place Text in Boxes ....................... 29
  Add a Logo .................................. 30
  Save Finished Form ......................... 31
  Printing the Form .......................... 32
Getting Started

Chapter 4: The Tool Bars
File Function Tools .......................... 34
Creating a New Form File .................. 34
Opening and Existing Form File ............ 36
Saving and Proof Printing Your File ........ 37
Drawing New Components .................. 38
Add Logo .................................. 40
Raster Image Properties Dialog .............. 41
Modifying the Size of Existing Logos ....... 41
Select Cursor Controls ...................... 42
Modify Size of Lines and Boxes ............. 43
Modify Drawing Tools ...................... 44
Move and Copy Tools ...................... 44
Plumb to a Position ....................... 46
Level to a Position ....................... 47
Scale and Rotate Tools .................... 48
Undo .................................. 49
Cursor Controls .......................... 49
Cut and Paste ................................ 50
Zoom Options .......................... 50
The Text Tools .......................... 51
Set Text Properties ...................... 51
Text Font Tab .......................... 52
Text Attributes Readout .................. 53
Check Spelling .......................... 53
Text Editor Selector ...................... 53
Set Line, Box, and Area Properties ........ 55
Components of Line Attributes Dialog Box ... 55
Box Attributes Dialog ................... 56
Area Attributes Dialog ................... 58
Electronic Field Tools ................... 59
Measure .............................. 60

Chapter 5: Understanding Your Fonts
Requirements ................................ 61
Installing Fonts on Windows 2000 ........... 62
Why Font Mnemonics Need to be Established ... 62
Setting Up Fonts In OneForm Plus .......... 63
Fonts Supplied with OneForm Designer Plus ... 64
Winfonts1.ini File ........................ 64
Matching MECCA Fonts ................... 65
PostScript and TrueType Differences ........ 66
Table of Contents

Chapter 6: Testing Installation for Visual Basic E-Forms
  Open the Accounting Form ................................ 69
  Use GenForm to Generate and Start the E-Form ... 70
  Using the Electronic Form ............................. 71

Chapter 7: Testing Installation for HTML I-Forms
  Open the Accounting Form ............................. 73
  Use GenForm to Generate and Start the I-Form ... 74
  Using the Internet Form ............................... 75
  Printing the HTML I-Form ............................ 76

Index ................................................. 77

Note: The complete set of OneForm Designer Plus Reference Manuals are available in Adobe Acrobat PDF format. They are located in the OneFormPlusDoc directory.
CHAPTER 1

Overview and Installation

Welcome to Amgraf’s OneForm Designer Plus

Amgraf’s OneForm Designer Plus software is a complete designer package for Electronic and Internet forms. A single design file can be published to multiple media formats as needed. It has both E-Form and I-Form capabilities, PLUS the addition of Amgraf’s MECCA III Business Forms Composition and Prepress Software for the accurate design and output of conventional paper forms.

Paper business forms, especially internal forms, are prime candidates for replacement with Electronic and/or Internet forms. Using Amgraf’s OneForm Designer Plus, paper forms can quickly be converted to E-Forms and I-Forms with the following benefits:

• The look and feel of the paper form is preserved. This reduces design and training costs, and allows users to gracefully migrate to electronic and Internet forms as needed.

• OneForm E-Forms are compatible with all Microsoft Windows PC’s, and OneForm I-Forms work great with Microsoft’s Internet Explorer Browsers.

• Existing form designs can be imported from almost any desktop publishing or forms drawing system.

• E-Forms and I-Forms can be linked together, connected to databases, e-mailed, and electronically signed and secured.

• When needed, a paper form can be printed on-demand.

• No filler software license fees are ever required to use the Electronic and Internet forms created with Amgraf’s OneForm Designer Plus.

OneForm Designer Plus is a complete E-Forms/I-Forms authoring tool, with features for the most demanding workflow projects. Because no filler software licenses are needed, OneForm is also the most affordable solution for enterprise-wide Electronic and Internet forms deployment.

Internet electronic forms (I-Forms) are generated as HTML pages with JavaScript coding for intelligence. VB electronic forms (E-Forms) are generated as Microsoft Visual Basic projects, then compiled and distributed as Windows “.exe” executables. Intelligent PDF I-Forms can be saved directly from OneForm by using the optional PDF Forms Generator Module.

Software to simplify the online hosting of I-Forms is also included with OneForm Designer Plus. Internet server control scripts are automatically generated for the rapid deployment of database-connected HTML and PDF forms. The highly efficient Common Gateway Interface (CGI) scripts are compatible with Microsoft and Unix web servers, and support most relational databases including those from Microsoft, Oracle, and MySQL.
Server script generation is very easy. The I-Form Server Preferences panel is used to quickly specify all of the server CGI scripts necessary to manage databases; open, save, and e-mail I-Forms; find and list saved I-Forms; and to perform XML data exchanges.

**Key Features for Paper Business Forms Design**

Compose business forms with confidence. OneForm Designer Plus provides the paper forms professional with all of the necessary layout and make-up functions to compose multi-color/multi-part business forms in either Spot Color or Process Color. Powerful drawing tools, along with a comprehensive library of templates, fonts, borders, and pantographs, enable the efficient creation of high quality cut-sheet, continuous, unit set, mailer, and other business forms.

- **Import Pre-Designed Business Forms.** The following formats can be imported: Encapsulated PostScript (.eps), PostScript (.ps), Portable Document Format (.pdf), and MECCA Graphics (.g).

- **Forms Design Tools.** Not only do you have the standard Draw Line, Draw Box, Place Text, Resize, Move, and Copy, you also have the extensive set of business form drawing features found on MECCA III Systems such as Scale, Rotate, Hold Position, and Step-and-Repeat, just to name a few.

- **Flat, Graduated, and Radial Screens.** Screens can be placed within boxes or any shape. They are controlled from 0% to 100% in 1% increments, while the screen lineage can be as coarse as 20 lines per inch or as fine as 150 lines per inch. The operator can choose either a flat screen, a graduated directional screen, or a graduation radiating from a specified center point.

- **Snap-to-Grid Background Reference.** Business forms can be accurately designed using the Snap-to-Grid and Window Zoom features. A grid of printable reference lines can be displayed on the screen to force alignment of items in the form. The operator can define the horizontal and vertical spacing of the points. Business forms with exact typewriter or computer-printer spacing in tenths and sixths are easily and accurately created with this feature.

- **Borders and Pantographs.** A wide variety of borders, pantographs, and blockouts can be merged from the 120+ stock library included with the package.

- **Color Separations and Layers.** Thirty-two layers (overlays) are supported for color separation and multiple-part forms. Text and rules can be assigned to a particular layer, and the operator can choose to display or hide individual layers or parts on the screen, as well as during printing. The Output Specification panel makes it simple to image up to 32 color separations in perfect registration on any PostScript device.

System Requirements
System requirements to install OneForm Designer Plus is a Pentium class CPU with a minimum of 64MB of RAM, SVGA Display, and available USB port, running Microsoft Windows 2000 or Windows XP. It is also necessary to have Microsoft Internet Explorer 5.01 (or higher) installed prior to installing OneForm Designer Plus.

The complete installation of OneForm Designer Plus takes up approximately 220 MB of hard disk space.

If using PostScript fonts, Adobe Type Basics is required. Also Adobe Type Manager Deluxe V4.0 or higher is necessary for PostScript font handling, for those still running Windows 98 or Windows NT.

PDF I-Forms require Adobe Acrobat Professional Edition V5.0 or higher. Microsoft Visual Basic Professional Edition V6.0 is only required if you intend on generating VB projects as the final electronic form. It is not necessary for the HTML Internet (I-Form) electronic forms.

About the Documentation
OneForm Designer Plus comes with five manuals in PDF format, expanding on the two printed booklets. These files are located in the OneFormPlusDoc directory.

Getting Started covers the software installation, basic tools, and system requirements.

Business Forms Composition and Typeset Output is designed to give you all of the details concerning the menus controlling illustrating and drawing of business forms. It includes several tutorials and complete details of usage for all tools and menus.

Creating E-Forms and I-Forms covers the basic steps for creating electronic executable forms and what is needed for generating HTML Internet forms. It includes tutorials for creating E-Forms and I-Forms with complete details on the electronic Field tools and menus.

Appendix A explains how to setup an I-Forms local internet server for testing.

FontBank Library contains a display of the design typefaces provided with the OneForm Designer Plus software.

Business Forms Library describes the library of 130 pre-designed electronic business forms provided with the OneForm Designer Plus software. These forms are indexed in 37 categories. They can be copied, opened, modified, and customized to create new forms.
Getting Started

Installing OneForm Designer Plus

Installing OneForm Designer Plus is very simple. It creates a directory called \Amgraf\OneForm under C:\Program Files unless told otherwise.

Installing on your Windows 2000 or XP System

(It is absolutely necessary to install MS Internet Explorer 5.01 or higher before installing OneForm Designer Plus. Also install Visual Basic first, if you will be generating electronic forms for VB projects.)

• Start Windows 2000 or XP as Administrator.
• Insert the CD into the CD-ROM drive.
• Click Start in the Taskbar and choose Settings, Control Panel. The Control Panel Appears.
• Double-Click Add/Remove Programs. The Add/Remove Programs Properties dialog box appears.
• Click the Install button (in the Install/Uninstall Tab), and follow the instructions in the dialog boxes.

Creating Visual Basic Electronic Forms:

Visual Basic Professional Edition V6.0 must be installed before using OneForm Plus to generate VB project form files for use on Windows PC’s and to create the final executable EXE. Follow their installation procedures.

OneForm Designer Plus needs to access Visual Basic during installation. This requires that Visual Basic be installed first. If this is not the case, install Visual Basic, then simply reinstall OneForm Designer Plus.

Software Security Device Needed

After installing OneForm Designer Plus, you must plug in the software security device into a USB port. This device is needed to open the OneForm Designer Plus software. The security device driver is supplied with the OneForm Designer Plus software, which is why the software must be installed first before attaching the device to your computer.

The security device (WIBU-KEY) will need the following setting adjusted after installation. Do the following:

1. Select Start, Settings, Control Panel
2. Select the WIBU-KEY option in Control Panel.
3. Select the Network Tab in the settings dialog.
4. Make sure in the WIBU-KEY Subsystems section that the Local (Kernel) is the only item checked. See Figure 1-1.
Technical Support

Amgraf provides technical support for registered users. Just call Amgraf Technical Support at 816-474-4797 for assistance. For the most efficient response, please have the following information on hand and be at your computer when you call:

- **OneForm Version Number.** This can be found in OneForm’s About.
- **Monitor Type and Resolution.** This can be found in Window’s Settings, Control Panel, Display, Settings.
- **Amount of RAM.** This can be found in Windows, My Computer, Properties. You get to it by clicking the right mouse button.

You may also contact Amgraf support by e-mail at support@amgraf.com.

Join the Amgraf User Group Forum for information on the latest software updates and Amgraf news.

Just go to http://amgrafusergroup.multiply.com/ and click on Join this Group.

Figure 1-1: Set the Security Device to Only Local
The Importance of Font Setup

Understanding fonts can be difficult. When should you use PostScript and when to use TrueType? Depending on your selection, there can be many adverse effects. Understanding the fonts and how they work can virtually eliminate any problems.

TrueType Fonts are great for forms being distributed as Visual Basic E-Forms or for the HTML I-Form which uses the browser’s Windows Print option and the standard Arial and Times Roman fonts. OneForm’s font default is TrueType Arial.

But for Paper Forms, the rule of thumb is to use PostScript fonts when designing files for use with any of the following OneForm Designer Plus options:

- Typeset Output Option
- Stationery Option
- PDF Generator Module

Installing New Fonts into Windows

The fonts must be installed into Windows before OneForm Designer Plus can find them. The requirements are different according to operating system and type of font.

PostScript: Windows 2000 and XP can recognize PostScript fonts. Use the method found under Control Panel, Fonts to install the required Adobe Type Basic Font Library. (If you are still on a Windows 98 or Windows NT, OneForm Designer Plus requires the use of Adobe Type Manager. Also, the Adobe Type Basic Font Library is necessary.)

TrueType: On a Windows 2000 or XP use Control Panel, Fonts to install the fonts.

Once the fonts have been installed, they will appear in the OneForm Designer Plus Font Setup list for their respective type: PostScript or TrueType.

Establish Font Mnemonics Needed

Since OFDP requires that you assign a unique font mnemonic (2 to 5 characters) for each font that will be used, decide what you are going to use as font mnemonics. The OneForm software recognizes fonts by their assigned mnemonic and not by their Font Name. OneForm Designer also has a requirement that one of the fonts be assigned a ge font mnemonic. It is usually reserved for one of the following: TrueType Arial or PostScript Helvetica.

Setting Up Fonts In OneForm Plus

The OneForm Font Setup option updates the Text Tool’s font selection list and insures an accurate font display and output within the OneForm Plus software.

Within File, Font Setup, there are two setup options: Postscript Font Setup and TrueType Font Setup. If you plan on using both font types, you must setup both.
Let’s look at the TrueType Font Setup. The following dialog will appear listing all TrueType fonts available. Sorting by Font Mnemonic will bring all fonts without a mnemonic to the top of the list. Those you want to use will need to have unique font mnemonics assigned.

Do this by highlighting the font and filling in a font mnemonic and style choice. You will see it update as you select [Modify Font]. Fonts are seen as families. The program will try to locate all associated styles within the family and assign the proper style mnemonics. It will not let you reference fonts it sees as different families with the same font mnemonic, without checking Allow Mnemonic with Multiple Families first.

![Font Setup Dialog Box](image)

Selecting [Add Default Fontcodes] will assign mnemonics to all fonts known using Amgraf’s defaults.

The Font Mapping dialog updates a configuration file: winfonts1.ini. If you need more information, see Chapter 5: Understanding Your Fonts.

**Note 1:** For True Type fonts to be seen in the Text Tool’s font list, the Fonts Setup, Allow True Type Fonts option must be checked. Also, you must Exit out of OneForm Designer Plus and restart for it to see any newly setup fonts in the Text Tool’s list.

**Note 2:** If a True Type Font is given the same mnemonic as a PostScript Font, the PostScript will be used instead. It is best not to use duplicates.
OneForm Designer Plus Profile

The OneForm Designer Plus Profile designates menu settings according to the type of forms needed: EForms/IForms and Paper Forms are the most common. These profile selections are found under the Option menu and defaults to EForms/IForms.

When Paper Forms is selected, Typeset Output replaces the Print option and Output Specifications for Parts becomes available.

Note: If changing your profile, OneForm must be exited and restarted for the change to be applied.

Other Profiles

Visual Basic Forms: This profile will open up menu options for generating Visual Basic Exe Forms (E-Forms).

Stationery Forms: The OFDP Stationery Option uses this profile.

OML Forms: The free OneForm Manager Light Option uses this profile.

XML Workflow and Report Designer are custom features.

Managed Forms, Portal Forms, and Workflow Enabled are options that control the OFDP Forms Portal.
CHAPTER 2

Starting OneForm Designer Plus

After you have installed OneForm, you’ll see the OneForm program listed under Programs: OneForm Designer Plus.

Open OneForm Designer Plus by clicking the Start button and then pointing to Programs and clicking OneForm Designer Plus. When OneForm Designer Plus loads, it is ready for you to create a new file or open an existing file.
Getting Started

**OneForm's Main Window**

OneForm's main window is similar to most other Windows applications.

- **Title Bar**  
  Displays the software and project name.

- **Menu Bar**  
  Holds drop-down menus that offer additional options not found on the Tool Bar.

- **Tool Bar**  
  Contains buttons that easily access tools and options.

- **Hint Bar**  
  Prompts the user what to do. It also displays the Cursor Location, Line Direction Lock, Grid and Component Snap, and Part Number and Layer Displayed.

Take a few minutes to acquaint yourself with OneForm's main window and the many features it has to offer. The OneForm window contains the following elements.

![Figure 2-2: OneForm Designer Plus Has Many Form Design Tools](image)

*Figure 2-2: OneForm Designer Plus Has Many Form Design Tools*
Opening a New File

OneForm Designer Plus by default creates (.g) graphic files. You may also create electronic form files that hold field components. These are recognized by their file extensions:

- **.g** – Graphic Files for Printing
- **.elf** – Electronic Form Files

Start out by selecting the [New File] tool and setting up the drawing properties.

![Figure 2-3: Use the [New File] Tool](image)

The file will be named ‘untitled.g’ unless you rename it here, or use the Save As menu later. If you type in a new name at this time, make sure to include an extension.

**File Naming Conventions:** The file name is very important to the whole process. It is used as the basename for any other files generated. The convention OneForm Designer Plus uses is an alpha/numeric name with no spaces or punctuation. The basename should be at least 3 characters. Always use an extension of (.g) or (.elf).

If you are creating VB E-Forms, the basename must meet Visual Basic guidelines which require that it start with an alpha character and be 3 to 8 characters.
Getting Started

[Okay] your settings. This will display a blank page on your screen. You are now ready to apply lines, text, and boxes onto the page.

![Page Creation](image)

**Figure 2-4: A Page is Created to Work On**

### Select Cursor Controls

Clicking on a component with the Select Cursor will initiate the Click-Drag feature. Once a component is selected, the keyboard arrows nudge the component. The amount can be controlled by inputting a value.

**Box/Field**
- Handle Click/Drag -> Move
- Inside Click/Drag -> Move
- Shift Click/Drag -> X/Y Constraint
- Ctrl Click/Drag -> Handle for Resize
- Ctrl-Alt Click/Drag -> Copy

**Vector**
- Click/Drag -> Move
- EndPoint Click/Drag -> Resize Line
- EndPoint Shift Click/Drag -> Move Endpoint
- Shift Click/Drag -> X/Y Constraint
- Ctrl-Alt Click/Drag -> Copy

**Text**
- Handle Click/Drag -> Move
- Inside Click/Drag -> Move
- Shift Click/Drag -> X/Y Constraint
- Ctrl-Alt Click/Drag -> Copy
- Dbl Click -> Edit

**Raster**
- Handle Click/Drag -> Move
- Inside Click/Drag -> Move
- Shift Click/Drag -> X/Y Constraint
- Ctrl Click/Drag -> Handle for Resize
- Ctrl-Alt Click/Drag -> Copy
Basic Drawing Tools

The drawing tools are easy to work with. For lines, simply choose Draw Line and make two individual picks; the start and end of the line. Boxes and Rectangles need two diagonal corners. Interactive Text just needs a pick for the position and you are ready to start typing. To quit out of text input, toggle off the Text Input tool or click your right mouse button to display a Pop-up menu and select Done.

![Draw Line](image1)

![Text Input](image2)

![Draw Box](image3)

![Draw Rectangle](image4)

*Figure 2-5: Tools for Creating Lines, Text, Boxes and Rectangles*

Pop-Up Menus Contain a Variety of Functions

You will find the right mouse button causes a “Pop-up” menu to appear with a variety of choices relative to the option you are currently using.

Other drawing tools on the vertical Tool Bar include: Draw Circle, Draw Spline, Draw Area, and Add Logo. Each tool has a Pop-up menu that contains a wide variety of options specific to the current tool. These will aid you in placing and editing components.

Text Editor Tool

There are two methods for inputting text: Interactive or Text Editor. When the Text Editor is off, the Interactive mode is in effect. The Text Editor can be turned on and off by toggling the Text Editor tool.

![Text Editor Selector](image5)

*Figure 2-6: On the Top Tool Bar is the Text Editor Selector*

When using the Text Editor, you simply choose the Text tool and pick the position in which you wish to place text. As long as you have the Text Editor turned on, the Text Editor will appear each time you begin placing text and each time you edit.
Getting Started

Pop-Up Menus

Pop-up menus contain a wide variety of options specific to the current component or tool chosen. The pop-ups can be accessed by a right mouse click.

The Pop-up menu holds many options that aid in modifying properties or positioning the component.

The following pop-up menu is associated with Lines. Use the Select Cursor tool to pick an existing line. Then, right-mouse to access the pop-up options.

![Figure 2-7: Pop-Up Menus Hold Many Varying Options](image)

Each component’s pop-up menu (along with associated Hot Keys) are discussed within the Business Forms Composition manual.
Saving a New File

Using the [Save] tool brings up the standard Windows dialog box if the file has not previously been given a name. Afterwards, it will simply save the file and overwrite with the current version.

![Figure 2-8: Use the [Save] Tool](image)
Getting Started

Quitting and Saving

You can close OneForm Designer Plus in one of three ways. If you have forgotten to save any changes before quitting, the program will respond with a “save changes” message.

• Choose the Exit command in the File Menu.
• Double-Click the Control Icon.
• Click on the Close Button.

You can also Save Files in one of three ways:

• Choose the Save or Save As command in the File Menu.
• Click the Save Button on the Tool Bar.
• Use the power key [Ctrl]-[S].

Note: There is also an Auto Save that saves major changes automatically to a temporary file. This file is named OFPsave.g. If your computer should shutdown while working on a OneForm project, this file will be referenced. Then when either New or Open is chosen, you will be prompted to keep the auto saved file. Immediately after loading, use “Save As” and resave using the original file name and continue working.

OFPsave.g is stored in in the C:\Program Files\Amgraf\OneForm\UserFiles directory.

Figure 2-9: The Tool Bar has a Save Now Button
Opening a File From the Library

There is an extensive library of forms ready for you to use. They can be customized for your particular needs. See the Business Forms Library for examples of each form.

OneForm’s library is located in the folder OneForm/Forms_Lib and contains a wide variety of forms in many categories. Notice that each form is in its own folder. This is necessary for containing the files created when generating an electronic form.

- Accounting
- Automotive
- Bill of Lading
- Bill of Sale
- Change Order
- Collections
- Credit
- Delivery
- Employee
- Estimate
- Expense
- Fax
- Inventory
- Invoice
- Medical
- Memo
- Order
- Packing
- Payroll
- Promissory
- Proposal
- Purchase
- Quotation
- Real Estate
- Receipt
- Receiving
- Reply
- Requisition
- Restaurant
- Service
- Shipping
- Signature
- Statement
- Stock
- Transmittal
- Travel
- Work Order
Opening an Existing Form

Select the Open File Folder Tool to open an existing form. The Open File dialog box takes you to the directory UserFiles. Backup to OneForm and go into the Forms_Lib directory. The first directory in the list is the Accounting category.

To open an existing accounting form double-click the accounting directory, this will take you into it, and you will see eight additional folders, one for each form designed for accounting. Double-click on account01 and select the account01.elf and Open.

Figure 2-10: The Forms Library Contains a Wide Variety of Forms
Below is the full path of the Accounting Form directory:
C:\Program Files\Amgraf\OneForm\Forms_Lib\accounting\account01

Figure 2-11: Highlight the File and Click [Open]
Opening an existing form will place you in the main drawing window ready to make any changes necessary.

Figure 2-12: The Accounting Form
CHAPTER 3

Tutorial – Drawing A New Form

This tutorial is designed to acquaint you with OneForm Designer Plus. The following will be covered in this Chapter:

- Setting Drawing Properties
- Setting Grid Properties
- Setting Component Properties
- Drawing Components
- Modifying Properties of Existing Components
- Adding Logos
- Saving Your File

Setup New Drawing Properties

The first step in creating a new form is to create a canvas to work on. When you click the New File tool you are taken into the Setup New Drawing Properties. Before selecting [Okay], you have an opportunity to type in a form name, form size, and select a color model.

Figure 3-1: Starting a New Form
We are going to draw a ‘‘While You Were Out’’ message form. Our new name is wywo.g and the size is 4 x 5 inches. Keeping the Form Type of Custom will give you an opportunity to type in the form size.

Our example is drawn as a ‘‘Spot Color’’ color model, so make that selection in the Color Model drop-down. This affects how the Set Attribute Dialogs display for choosing colors.

[Okay] confirms your choices and closes this dialog box.

Take a moment to look at the components which make up this form.

---

Figure 3-2: Draw the “While You Were Out” Message Form
Chapter 3: Tutorial – Drawing a New Form

**Turn on a Grid**

A blank page will appear ready for you to start creating components. OneForm has a handy grid option which assists in accurate component placement. The Grid Properties dialog is found under the Options menu.

![Grid Properties Window](image)

Figure 3-3: The Grid Assists in Accuracy

Once the Grid Properties Window appears, you will then be able to customize your grid. You may choose [On] or [On/Snap] to turn on your Grid. [On/Snap] will not only turn on your grid, but will snap all of your components to it. This is the option we want to use for our form. Options such as the horizontal and vertical spacing, and units can be determined here. Setup the grid with the same spacing as shown in Figure 3-3.

**Draw All Ruling First**

The easiest way to start a new form is to draw all ruling first as a foundation for the form using the line and box tools. Creating text and placing it into the correct position would be next. Adding any other items such as screens or logos is usually the last step in forms design.

Looking at our form we have many lines, a few boxes, and lots of text. Since we want to draw all ruling first we will start by learning how to set the properties for lines and boxes before drawing.
Getting Started

**Set Line and Box Attributes**

Before drawing you have an opportunity to setup the style of your lines and boxes through the Set Properties tools. Set both of them to 1-point weight. While you are in the Box Properties, go to the Inside Tab and set the inside color densities to “None” meaning transparent.

![Figure 3-4: The Set Attributes Dialog Boxes](image)

---

24 OneForm Designer Plus – Ver 4.7.2.2
Draw Lines and Boxes

We are now ready to draw the first box with its 1-point rule while picking on the grid for positioning. The second box needs a 2-point rule, so go back into the Set Box Properties tool and set it before drawing.

Our lines are 1-point rules and we have previously set the properties. When drawing lines, it will be helpful to have them locked in one of eight positions. To get Eight Direction lines only, toggle on the Lock Eight Directions tool. Hot Key: Hold down the Shift key while drawing lines.

The beginning of the lines can be adjusted later, using the pop-up menu option Modify End of Line. For now, just pick an approximate location.
**Getting Started**

**Drawing Multiple Lines**

The **Draw** menu holds other drawing options. Under **Vector** you will find an option for drawing **Prorated Lines**. Setup the properties through the dialog and then draw your rectangular shape.

![Figure 3-7: Draw Equally Spaced Lines](image)

This will give you equally spaced lines with 2 internal horizontal lines and 1 internal vertical line. Now you can move the vertical line over to the left.
**Place Text**

On the top tool bar, the Set Text Properties tool allows you to setup text attributes before creating the text. The Text Attributes Readout displays the current Font Style, Size, and Composition Position.

![Figure 3-8: The Set Text Properties Dialog Box](image)

To create text use the Input Text tool. Pick a position and start typing. To quit out of text input, toggle off the Text Input tool.

**Modify Lines if Necessary**

You can now modify the lines to be closer to the text. But before doing so, toggle off the Grid Snap tool on the left. Use the Select Tool to pick the line and press your right mouse button. Choose Modify End of Line and pick the end to move, then its new location.

![Figure 3-9: The Lines can be Modified](image)
Getting Started

Modifying Text Properties

If you happen to forget to set the text properties to the desired attributes before creating the text, you don’t have to delete it and start over. Just modify the existing text component’s properties.

Component properties are accessed through a Pop-up menu. Use the Select Tool to pick the text item first and press your right mouse button. Select the Properties Change option and the Modify Text Properties dialog will appear.

![Figure 3-10: Getting to the Modify Properties Dialog](image)

Figure 3-10: Getting to the Modify Properties Dialog
Place Text in Boxes

This handy option allows you to place multiple text pieces easily. After selecting Okay for the gutters and composition modes, it will prompt you to draw a dynamic rectangle. It uses this rectangle to provide the region in which it looks for box shapes. The positions will be portrayed by red lines.

Select Start Inputting Text from the right-mouse pop-up menu and type in the text, and press [Tab]. The cursor will move to the second location. Type in each piece of text and [Tab] to finish.

Figure 3-11: The Red Diagonal Line Indicates a Text Position
Getting Started

Add a Logo

A scanned logo can be brought into your form through the Add Logo tool. Pick where the top of the logo will fall. This will bring up the Raster Image dialog so you can locate the image file (BMP, GIF, JPEG) you wish to include. Once it is brought into your drawing, it can be moved, copied, and scaled.

Figure 3-12: Add a Logo to Give it a Custom Finish
Save Finished Form

As you can see we now have a finished form.

Save your file often by using the **Save File** tool.

*Figure 3-13: Use the Save Icon to Quickly Save any Changes*
Getting Started

Printing the Form

When you select Print you will be printing through Windows Print Manager.

Note: The Print option will be disabled and replaced with Typeset Output if you choose the OneForm Profile of Paper Forms.
CHAPTER 4

The Tool Bars

The OneForm Designer Plus tools help you perform common tasks quickly. Each of them have right-mouse pop-up menu options available. The tools are described in the following usage groupings:

- File Function Tools
- Drawing New Components
- Modifying Properties and Size with the Select Cursor
- Modify Drawing Tools (Move, Copy, Scale, Rotate)
- Undo
- Cursor Controls
- Cut and Paste
- Zooming Tools
- Text Tools
- Set Line, Box, and Area Attributes
- Fielding Tools
- Measure

Figure 4-1: The Tool Bars are Active after Starting a New Form
Getting Started

File Function Tools

The File function tools are the shortcuts to New, Open, Save and Print. New File creates a new graphic ".g" file which is an 8.5" x 11" page for you to start designing your own form. The Open File tool allows you to browse through your directories to open existing graphic files. Save File will save the current version under the existing file name, and Print takes you to the standard Windows Print dialog box for proof printing.

Creating a New Form File

Selecting New immediately brings up a Set New Drawing Properties dialog box for naming the new file. This dialog allows you to setup the properties pertaining to the new file.

Creating a New Form File

Selecting New immediately brings up a Set New Drawing Properties dialog box for naming the new file. This dialog allows you to setup the properties pertaining to the new file.

By default the file created will be a graphic file (.g) ready for printing. The files are stored in the directory C:\Program Files\Amgraf\OneForm\UserFiles unless specified otherwise.
Creating a New Form File

Before selecting [Okay], you have an opportunity to setup the following items:

**File Name:** The file name is very important to the whole process. It is used as the basename for any other files generated. The convention OneForm Designer Plus uses is an alpha/numeric name with no spaces or punctuation. The basename should be at least 3 characters. Always use an extension of (.g) or (.elf).

If you are creating VB E-Forms, the basename must meet Visual Basic guidelines which require that it start with an alpha character and be 3 to 8 characters.

**Date Initialized:** This is the date the file was originally created. The date is generated by the computer and cannot be changed.

**Operator ID and Job Number:** Here you can input names and job numbers to assist in production management.

**Form Type and Template:** Having Custom as the form type and template allows you to input your own form width and depth.

In the dropdown list is a library of the most commonly used business form types and template sizes, ready to be used with registration marks. The template sizes are controlled by the type of form chosen. See the Business Forms Composition manual for the layouts.

**Form Width and Depth:** This determines the size of form you are creating. The default is in the Units of points. You can change this to inches.

**Form X Origin and Form Y Origin:** This represents the location of the form’s lower-left corner.

The options for **Color Model, No. of Parts, Spec. File, and Layer Color** all deal with Color display and printing. You are able to create either Process Color or Spot Color files. The difference in printing techniques are significant and affect the creation and output process. ‘‘Process’’ color is based on a Color Number made from the four colors: cyan, magenta, yellow, and black. Whereas, ‘‘Spot’’ color refers to a pre-mixed ink color and is controlled by our Layer attribute. See Business Forms Composition, especially Chapter 8: Working with Color.

**Comments:** This is a handy place to keep comments concerning production of the job.

You can modify the Drawing Properties through the Options menu.
Opening an Existing Form File

When you click Open on the Tool bar, you are opening an existing file. It will bring up a dialog box listing all valid files in the UserFiles directory.

The standard OneForm Designer Plus can open two types of files:

- .g – OneForm Designer Plus/MECCA Graphic Files
- .elf – OneForm Designer Plus/MECCA Electronic Form Files

You may look in another location by clicking the “Look In” box and double-clicking the name of the folder that contains the file you wish to open. Continue doing this until you get to the folder which holds your file. Then, in the list of files, click the file name and select [Open].

You can also back out of the UserFiles folder by clicking the Close Folder icon.

A Shortcut: If you have opened the file recently, it may be in the file name list in the bottom of the File menu. There will always be a list of the last ten files opened. Just select the name from the list.
**Saving and Proof Printing Your File**

When you select **Save**, the action is immediate. You are overwriting the existing file with the current version.

The **Save As** allows you to save items under a different name. Here you have an opportunity to give it a new name or save it in a different location. You may find another location by clicking the “Save In” box and double-clicking the name of the folder you wish to use. Continue doing this until you get to the new location. You can also back out of the UserFiles folder by clicking the Close Folder icon.

When naming files remember to use the file naming conventions described on page 35.

**Printing the Form**

When you select the **Print Form** you will be printing through Windows Print Manager. Use your View selections to print the form with (Normal Fields) or without (No Fields) electronic form fields. File’s Print option includes the standard Windows Print Manager: Print, Preview and Print Setup.

![Windows Print Dialog](Image)

**Figure 4-5: Windows Print Dialog**

For outputting to high-resolution devices or proofing files that ultimately will be typeset use the **Typeset Output** menu instead of the print tool. See the *Business Forms Composition* reference manual for more information.

*Chapter 4: The Tool Bars*
Getting Started

**Drawing New Components**

![Image of drawing tools]

Draw Line
Input Text
Draw Box
Draw Circle
Draw Spline
Draw Rectangle
Draw Area
Add Logo

Figure 4-6: All of These Tools Create New Components

Each of these tools create components and add them to your drawing. You will find the right mouse button causes a Pop-up menu to appear with a variety of choices relative to the drawing tool you are currently using.

Following you will find the simplest form of usage for each tool to give you a general idea of how they work.

**Draw Line:** To create a line, you would pick the Draw Line tool first. Then pick two points on your page representing the start and end of the line. You will stay in the Draw Line tool until you toggle out of it or pick another drawing tool. All lines drawn will have the properties specified within the Set Line Properties dialog.

**Input Text:** Inputting text requires just a position pick after selecting the Input Text tool. The text cursor will appear ready for you to start typing. The position of the text is relative to the position picked and its composition mode: Flush Left, Flush Right, Centered, or Justified. You must toggle out of the Input Text tool or select Done within the Pop-up menu to end Text Input.

**Draw Box:** Drawing a box simply requires selecting the Box tool and picking two diagonal corners. Box components have additional attributes which can be applied, such as rounded corners, screens, bars, borders and pantographs. Setting up the properties for a box is through the Set Box Properties tool described in complete detail within the *Business Forms Composition* manual.
Drawing New Components

**Draw Circle:** This option lets you create full or partial circles. For a full circle pick the center and tangent. The line weight of a new circle is controlled by the Set Line Properties tool.

**Draw Spline:** This tool draws curved lines. After picking the Spline tool, select four control points on the screen to represent the anchors the curve is to travel through. Finish by right-clicking and choosing Done. The line weight of a new spline is controlled by the Set Line Properties tool.

**Draw Rectangle:** Drawing a Rectangle simply requires selecting the tool and picking two diagonal corners. The line weight of a new rectangle is controlled by the Set Line Properties tool.

**Draw Area:** An Area is a screen or solid fill with a closed boundary made up of lines, circles, rectangles, or splines. The properties of the new area is controlled by the Set Area Properties.

![Figure 4-7: Types of Drawing Components](image)
Add Logo

Adding a logo to a form is done by choosing the Add Logo tool. You then need to pick the position for the upper-left corner of your logo. This will bring up the Raster Image Properties dialog window. After selecting the logo, a preview will appear showing your selection. Click [Okay].

Figure 4-8: Adding a Logo
Modifying the Size of Existing Logos

Raster Image Properties Dialog

The Raster Image Properties dialog gives you the ability to browse for the logo and size it before being added to the form.

Once a logo has been selected, you will see a location path in the Path field and a preview of the image in the Preview box. (Gif files cannot be previewed.)

There are a number of valid logo file types that can be brought into OneForm Designer Plus.

- **Logo Description and Extension:**
  - BMP (*.bmp)
  - LEAD (*.cmp)
  - GEM Image (*.img)
  - GIF (*.gif)
  - JPG (*.jpg, *.jpeg, *.jff, *.jtf)
  - Macintosh Picture (*.pct)
  - MacPaint (*.mac)
  - Microsoft Paint (*.msp)
  - PCX (*.pcx)
  - Photo CD (*.pcd)
  - Portable Network Graphics (*.png)
  - Sun Raster (*.ras)
  - TGA (*.tga)
  - TIFF (*.tif)
  - Windows Icons and Cursors (*.ico, *.cur)
  - Windows Metafile (*.wmf)
  - Winfax (*.fxs)

  Of these, two are valid logo file types for use with HTML Internet forms:
  - GIF (*.gif)
  - JPG (*.jpg, *.jpeg, *.jff, *.jtf)

The **Height** and **Width** fields are the physical dimensions of the logo. These values can be changed in order to control the final size of the logo.

The **Layer, Color, and Screen Properties** can only be set at the time the logo is brought in. For details on these properties see Set Line Attributes.

**Original Size** imports the logo with no distortion. The image can be scaled by moving the **Scale** slider bar scale bar from left to right. The **Height** and **Width** values will display the image size as the percentage changes.

Modifying the Size of Existing Logos

If existing logos need to be resized, pick on the logo with the Select Tool and then choose the **Modify Logo Size** in the pop-up. You will be given an opportunity to pick a side or corner to modify. Raster Properties does not allow you to resize, it only reports the current size.
Select Cursor Controls

Clicking on a component with the Select Cursor will initiate the Click-Drag feature. Once a component is selected, the keyboard arrows can "Nudge" the component. The amount can be controlled by inputting a value.

<table>
<thead>
<tr>
<th>Box/Field</th>
<th>Vector</th>
</tr>
</thead>
<tbody>
<tr>
<td>Handle Click/Drag -&gt; Move</td>
<td>Click/Drag -&gt; Move</td>
</tr>
<tr>
<td>Inside Click/Drag -&gt; Move</td>
<td>EndPoint Click/Drag -&gt; Resize Line</td>
</tr>
<tr>
<td>Shift Click/Drag -&gt; X/Y Constraint</td>
<td>EndPoint Shift Click/Drag -&gt; Move Endpoint</td>
</tr>
<tr>
<td>Ctrl Click/Drag -&gt; Handle for Resize</td>
<td>Shift Click/Drag -&gt; X/Y Constraint</td>
</tr>
<tr>
<td>Ctrl-Alt Click/Drag -&gt; Copy</td>
<td>Ctrl-Alt Click/Drag -&gt; Copy</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Text</th>
<th>Raster</th>
</tr>
</thead>
<tbody>
<tr>
<td>Handle Click/Drag -&gt; Move</td>
<td>Handle Click/Drag -&gt; Move</td>
</tr>
<tr>
<td>Inside Click/Drag -&gt; Move</td>
<td>Inside Click/Drag -&gt; Move</td>
</tr>
<tr>
<td>Shift Click/Drag -&gt; X/Y Constraint</td>
<td>Shift Click/Drag -&gt; X/Y Constraint</td>
</tr>
<tr>
<td>Ctrl-Alt Click/Drag -&gt; Copy</td>
<td>Ctrl Click/Drag -&gt; Handle for Resize</td>
</tr>
<tr>
<td>Dbl Click -&gt; Edit</td>
<td>Ctrl-Alt Click/Drag -&gt; Copy</td>
</tr>
</tbody>
</table>

Modify Properties with the Select Cursor

The Select Cursor is used to modify the properties of existing items. For example, toggle on the Select tool and pick on the item to modify. Notice that handles will appear showing you that it has been selected. By clicking your right mouse button while the item is selected, a Pop-up menu will appear with choices relative to that component type. Selecting Properties will bring up a Modify Properties dialog (for that component) allowing you to change them. Note: When the Select Cursor picks the page, its pop-up menu is a shortcut to the Text Editor Selector and Group.

Figure 4-10: Use the Select Tool to Modify Properties
Modify the Size of Lines and Boxes

Use the Select Cursor to alter the size of existing lines and boxes. Toggle on the Select tool and pick on the line to modify. Notice that handles will appear showing you that it has been selected. By clicking your right mouse button while the line is selected, a Pop-up menu will appear with choices for modifying its length. Descriptions of these options are below:

**Modifying Lines**

**Break Line:** is when you want to create a break in an existing line. This option breaks a line into two segments or cuts out a middle portion of the line. After choosing a line with the select cursor, choose *Break Line* and pick the two points where you want to break the line. Finish the process by selecting *Done* in the Pop-up menu.

If the two picks are the same point, the line will be broken in two with no obvious break. If the two picks are different, the section between the two picks will be cut.

**Trim Line:** This will trim lines in reference to another line. Choose your Select tool and the line that will be your trim marker. Right-click your mouse and choose *Trim Line*. Click on the end-point of the line you want to trim. Choose *Done Trimming* in the Pop-up menu when finished.

**Modify End of Line:** This is a method for lengthening or shortening your line. With Modify End of Line, you can extend or shorten the length of the line without changing the angle of the line. After selecting the line with the Select tool, choose this option and select the end to modify. Now, simply pick on the new position.

**Move End Point:** This will allow you to change the position of the end of your line; including the angle. Choose the Select tool and the line. Right-click your mouse and choose *Move End Point*. Pick the end that you want to move and pick a new location. Notice this option will change both the direction and length.

**Modifying Boxes**

**Modify Box Size:** This will resize a box by grabbing a side (or corner) and clicking on the new position. Use the Select Tool to pick a box, then choose *Modify Box Size* and grab a side or corner of the box. As you move the cursor, you will see the box size change. Pick the new position for your side or corner.

**Divide Box into Rows:** This divides a box into rows and creates two separate boxes. Dividing a box is as simple as choosing the box to divide and selecting the option. Pick the position in which you want to divide the box. The box is immediately divided into two. 

**Divide Box into Columns:** This works in the same manner as Divide Box into Rows, it just cuts the box vertically. Shortcut is [CTRL]+[F12].
Getting Started

Modify Drawing Tools

![Move, Copy, Scale, Rotate tools]

Figure 4-11: These Tools allow you to Modify Existing Components

The Modify Options allow you to Move, Copy, Scale, or Rotate any component. After picking a Modify tool, choose the component to modify. These tools also work with Groups of components.

Move and Copy Tools

Move and Copy: Choosing the Move or Copy tool on the tool bar allows you to move or copy any component to a new position. These tools work in an identical manner, so we will explain the concept through the move.

Moving a component is easy. After picking the Move tool, pick the component. Then pick a handle and its new position. To constrain the movement to 90-degree positions, go to the Pop-up menu.

![Move and Copy Pop-Up Menus]

Figure 4-12: The Move and Copy Pop-Up Menus are Similar
Tools to aid you in moving and copying components can be found in their respective Pop-up menu. Descriptions of these tools are found below:

**Horizontal Only**: This only allows movement in the horizontal direction.

**Vertical Only**: This only allows movement in the vertical direction.

**Repeat Last Move**: This will replicate the previous "move" both in direction and distance. This is not a continuous function and must be chosen each time that you want to repeat the move. [Ctrl+F10] is the shortcut.

**Repeat Copy**: This will repeat your last copy; both in direction and distance. [Ctrl+F10] is the shortcut.

**Bring Others**: If you move a component within a group and you want to move the other components so that they remain in the same relationship to the component moved, choose "Bring Others." Begin clicking on the other components, they will be moved to the new position so that they remain in the same relationship as they were to the original. This is a continuous function and will continue to allow you to "Bring Others" until you choose Done in the Pop-up menu.

**Copy Others**: If you have a group of items and you copy a component within that group, you may use "Copy Others," and select the other components to copy. Upon clicking on them, they will be copied to the new position so that they remain in the same relationship as it was to the original. This is a continuous function and will continue to allow you to "Copy Others" until you have chosen Done in the Pop-up menu.

**Step Count**: This will allow you to copy an item multiple times by entering the number of copies and distance in both the horizontal and vertical direction. This will create multiple copies in one easy step.
**Plumb to a Position**

The Plumb to a Position option is found under the Move and Copy pop-up menu. It moves/copies items left and right.

To use “Plumb To A Position”, first choose either the “Move” or “Copy” tool. Next, right click your mouse and choose Set Plumb in the Pop-up menu. You will be prompted to “Pick Plumb X Point”, this is the left/right position that you wish items to line up with. A yellow vertical reference line should appear at the identified point. Click on the object that you wish to Move/Copy. Bounding box handles will appear and the pointer will change to the “plumb pointer”. Click upon one of the handles and the item will Move/Copy left or right placing the chosen handle against the vertical plumb line. Continue identifying objects and clicking on their handles until all objects are lined up. The “Plumb To A Position” option will remain active at all times when using Move/Copy until it is deactivated in the Pop-up menu. When finished moving, uncheck To Plumb Position.
The Level to a Position option is found under the Move and Copy pop-up menu. It moves/copies items up and down.

To use “Level To A Position”, first choose the “Move” or “Copy” tool. Next right click your mouse and choose Set Level in the Pop-up window. You will be prompted to “Pick Level Y Point”, this is the up/down position that you wish items to line up with. A yellow horizontal reference line should appear at the identified point. Now click on the object that you wish to Move/Copy. Bounding box handles will appear and the pointer will change to the “level pointer”. Click upon one of the handles and the item will Move/Copy up or down placing the chosen handle against the horizontal level line. Continue identifying objects and clicking on their handles until all objects are lined up. The “Level To A Position” option will remain active at all times when using Move/Copy until it is deactivated in the Pop-up menu. When finished, uncheck To Level Position.
Scale and Rotate Tools

Scale and Rotate both operate in a similar fashion in that they need two pieces of information before any action can take place; an anchor position and a value.

To resize a component choose the Scale tool and select the item to modify. Handles will appear noting it is selected. The Hint Line at the bottom of the screen will prompt you to “Pick Center to Scale”. This is the anchor position of the component as it is scaled; it will shrink or grow from that position. Once you have chosen the Center position, the Scale dialog box appears automatically for you to input the scale factor. The scale factor is the fraction in which you want to increase or decrease the size of the component. Click on [Okay] to accept the value and see the component resize. Hint: Just filling in X-Scale will always proportionally scale.

Figure 4-15: Scale Size Dialog Box

Pick the Rotate tool to spin the item counter-clockwise. Select the item to modify. Handles will appear noting it is selected. The Hint Line at the bottom of the screen will prompt you to “Pick Center to Rotate”. This is the anchor position of the component as it rotates; it will rotate around that position. Once the center has been chosen, the Rotate dialog box will appear. You may then enter the angle in which you want to rotate the component (boxes however can only be rotated in 90 degree increments), and select [Okay]. The object will rotate. Also for rotate are options within the Pop-Up menu for aiding in rotation.

The following tools aid in scaling and rotating items. They can be easily accessed through their respective Pop-up menu. Descriptions of these tools are found below:

Pick Center: This will find the center point in which you wish to scale/rotate an item from. This is the position that will be fixed to the site as the other sides change when scaling or rotating.

Key in Size: This is the scale factor. The scale factor is the fraction that you are scaling the component.
Cursor Controls

**Key in Angle:** This is the angle you wish to rotate your component. Input the angle in degrees that you wish the component is to be rotated.

**Repeat Rotate/Scale:** This will repeat the last rotation or scale by the degrees or Scale Factor set in the dialog.

**Rotate/Scale Others:** This will rotate or scale other components on the form using the values set in the respective dialogs.

**Make Copy** only works with the Rotate tool and is not yet supported for Scale. When checked, this will produce X number of copies rotated Y degrees on the center point. The number of copies is determined in **Copy Count**.

**Copy Count** is only available for Rotate and is not yet supported for Scale. This is the number of copies to be rotated on the center point.

**Undo**

Figure 4-16: Undo Tool

The **Undo** tool will restore the last modify option which took place. It is an unlimited Undo, up to your last Save.

**Cursor Controls**

**Grid Snap On/Off**

**Component Snap On**

**Eight Direction Lock**

Figure 4-17: Grid On with Eight Direction Lock Assists in Accuracy

**Grid Snap On/Off** is a handy toggle that when ‘ON’ will snap components to the grid. The Grid Setup can be found under the Options menu. **Comp Snap** will snap your component to other nearby components. **Eight Direction Lock** forces lines to be drawn in only eight directions: 0, 45, 90, 135, 180, 225, 270, and 315 degrees. Toggling it off will draw lines in all directions. Both of these options are great when ruling a form. They keep the lines straight and on the grid. The Eight Direction Lock works with boxes as well. When drawing a box, the Eight Direction Lock will lock the box into a square.
Getting Started

Cut and Paste

Figure 4-18: Cut / Copy / Paste

These options are standard editing options of Cut, Copy, and Paste, with a twist. To cut or copy, first Group Select Pick the item. Then, choose the Cut or Copy tool on the Toolbar. Finally, click the Paste tool and the position to paste. You can continue pasting the items into new locations as many times as needed. The items remain on the clipboard (a temporary storage area) until you cut or copy again. These options allow you to copy items to other files. The items will be pasted on the new page as a white group of components. It will be necessary to use Edit’s menu option of Group Unselect All to unselect.

Zoom Options

Figure 4-19: Down / Up / Zoom Area / Fit Screen

The Zoom options available allow close up viewing of details. Zoom Up brings you closer to the screen, while Zoom Down moves you away from the screen. The Zoom Area option allows you to select any area within a rubberband box by making two picks. This is an easy method to zoom into a specific area. To revert back to the entire graphic, choose Fit Screen.
The Text Tools

There are four tools that work specifically with text. The first one is for creating new Text Input. This requires a position pick after selecting the Input Text tool. The text cursor will appear ready for you to start typing. The position of the text is relative to the position picked and its composition mode: Flush Left, Flush Right, Centered, or Justified. You must toggle out of the Input Text tool or select Done within the Pop-up menu to end Text Input.

Set Text Properties

The Set Text Properties gives you the ability to set (or describe) the attributes of any new text item before it is created. When the Set Text Properties icon is picked you will see the dialog box appear:

![Set Text Properties Font Tab Dialog](image)
Once all text attributes have been selected, choose the [Okay] button to accept them. Then whenever you create a piece of text through the Input Text tool, these attributes are used. The attributes chosen will appear in the Readout.

The only attributes which will be discussed here is the Text Font Tab. All others are completely detailed in the manual for Business Form Composition. See Chapter 6: Working with Text.

**Text Font Tab**

The following are components of the Text Attributes:

- **CompMode** –
  - FL = Flush Left
  - FR = Flush Right
  - CE = Centered
  - JU = Justified
  - FLC = Flush Left Centered
  - FRC = Flush Right Centered

- **Font Name** – Font Selected from List

- **H-Size** – Horizontal Point Size

- **V-Size** – Vertical Point Size

- **Lead** – Baseline-to-Baseline Leading in Points

- **Rotation** – Angle Position of Text

The **CompMode** (Composition Mode) field has a drop-down list of four different modes which are: Flush Left, Centered, Flush Right, and Justified. This controls how lines of text are placed within your text box.

Flush Left aligns all left edges, Flush Right aligns right edges, Centered will center all lines over each other, and Justified will adjust each line’s spacing to align both the left and right edges of the text.

The **Font Name** field shows what font is currently selected. Clicking on the [...] button next to the Font Name field will bring up the font list of all fonts accessible to your system with their associated font mnemonic. Select the font/style needed and then click the [Okay] button.

The next options control the size of your text. The **HortSize (Horizontal Size)** field controls the width of the text and the **VertSize (Vertical Size)** field controls the height. These values can be entered in 1/10th point increments. When they have two different values, you are requesting it to expand or condense the font.

**Leading** controls the spacing from the baseline of the first text line to the baseline of the second text line. The values can be input in 1/10th point increments. It is recommended that the leading be equal to or larger than the vertical size of the text to keep lines from oversetting.

The **Left Margin** is the point where your first character of your lines will align. The **Right Margin** determines where your line will end and begin to wrap to the next line.
Chapter 4: The Tool Bars

Text Attributes Readout

| Arial | 10.0/10.0 | FL |

Figure 4-23: Font / Horizontal Size / Vertical Size / Composition Mode

The Text Attributes Readout displays a quick reference as to the Font Style, Font Size and Composition Mode of your Text Attributes. Font Characteristics cannot be changed here and simply represent the characteristics determined in your Text attributes. When in a text box, this will display its current font characteristics: Font, Size, Style and Composition mode.

Check Spelling

Figure 4-24: Spelling Tool

You can check the spelling of text with the Check Spell tool. If no text is picked or grouped, it will run through the entire file and show you a bounding box to identify the text it is currently checking.

To check a portion of the file, group the text to be checked and then choose the Check Spelling tool. To check just one text component, identify it with the select cursor. The Check Spell tool will then only check the text within that text bounding box.

Interrupting the Check Spell program, must be done cautiously. If you do not allow it to complete the entire task and you close or cancel too soon, the last task is considered cancelled. To avoid a Replace not taking place, just select Ignore before the Cancel. Then the last task is the Ignore not a Replace.

Text Editor Selector

There are two methods for entering text: Interactive or Text Editor. When the Text Editor is off, the Interactive mode is in effect. The Text Editor can be turned on and off by toggling the Text Editor tool.

Figure 4-25: Text Editor Selector Tool

When using the Text Editor, you simply choose the Text tool and pick the position in which you wish to place text. As long as you have the Text Editor turned on, the Text Editor will appear each time you begin placing text and each time you edit.
Getting Started

Figure 4-26: Notepad Text Editor Allows Immediate Commands

Advantages of Using the Text Editor

You may enter text using all of the notepad features such as the [Del], [Arrow] keys, [Insert], [Page Up] and [Down] along with cut and paste. Also, the text can have embedded MECCA Immediate Composition Commands.

Note: If you are using Windows NT, it is likely that you will receive an error when using the Text Editor. The problem lies in the location of the Notepad.exe in Windows NT versus Windows. OneForm Designer looks for the Notepad in a directory named C:\WINDOWS. In the NT, there is no such directory.

The fix is to create a folder directly under the C drive called WINDOWS and copy the Notepad.exe into this folder. This should take care of the problem.

Text is discussed completely within the manual for Business Forms Composition. See Chapter 6: Working With Text.
Set Line, Box and Area Properties

These three tools are for controlling the characteristics of items which have not been drawn yet. You are “setting the look” before the item is to be drawn.

Components of the Line Attributes Dialog Box

The Set Line Properties gives you the ability to set (or describe) the attributes of any new line, rectangle, circle, or spline component. When the Set Line Properties icon is picked you will see the following dialog box appear.

Weight – Line Thickness Shown in Current Unit
Style – Line Style Used: Solid, Dashed, Dotted, etc.
Layer/Color – 1 - 32 Layers and the Percentage of Color for Spot Color files or a Four Color Process Number for Process Color.
Getting Started

The default attributes for the Draw Line tool is a Black, half-point solid line. If you need to draw your lines in Blue instead, you can easily set the properties ahead of time.

When the form’s Color Model (found in the Drawing Properties option) is Spot Color, then the line attributes dialog will allow you to pick from the stock 32 different Layer Colors.

If your form’s Color Model is Process Color, then getting a Blue requires you to pick a Four Color Process Number that represents Blue, such as 300, or 289, or our number 4.

The Box Attributes Dialog Box

By setting the values for the Draw Box tool you can easily create any type of box needed in your form. The Set Box Attributes has Edges, Corners, and Inside tabs for basic box attributes.
Chapter 4: The Tool Bars

The Box Attributes Dialog Box

Box Attributes are:
Edges and Corners are
One-half point weight, solid style, black.
All corners are Inverted Round, 15 point Radius.
Inside Screen is 5% Gray.
Screen Lineage is 100.

Box Attributes are:
Edges and Corners are
2 point weight, solid style, black.
UL and UR corners are Round, with 30 point Radius.
LL and LR corners are Square.
Inside Screen is 1-15%
Graduated at Angle 270.
Screen Lineage is 80.

Figure 4-31: Box Attributes Define the Look of the Box

Weight – Line Thickness Shown in Current Unit
Style – Line Style Used: Solid, Dashed, Dotted, etc.
Layer/Start and End Color – 1 - 32 Layers and the Percentage of Color for Spot Color files or a Four Color Process Number for Process Color.

The Edge and Inside tabs both have a Layer/Color choice. The color chip shows you the current color. It can be accessed once you click the [...] button.

Figure 4-32: Spot Color Files Control Color with Layers

This shows you which layer the component is on and what color the layer represents. Box insides can have two colors applied allowing a graduating affect. The Color Chip shows the intensity of the color, where 0% represents white and 100% represents solid.
Getting Started

Screen Type: When asking for a graduation, dots normally produce the effect. There are a variety of dot shapes which are controlled by the Psdots.ps file on the originating System. This effect can also be created by lines. The defaults are dots or lines.

Set Graduation Angle: This lets you type in the angle for the direction of graduation from the Start Color to the End Color. Think of a compass in which the origin is the Start Color and the angle represents where the End Color will land.

Graduation Type: This describes the color variance affect. This is either no transition (None), transition along an angle (Directional), or transition from a central point (Radial). When Radial is selected a Radial Center X and Y starting point can be entered.

Area Attributes Dialog Box

Creating an area requires several basic picks. The area attributes are controlled by the current setups in the Area Attributes dialog box. This dialog has the same values as the Line and Box Attributes.

![Figure 4-33: Set Areas Properties Dialog Box](image)

This dialog has the same values as the Line and Box Attributes.

Once you have defined the characteristics of the Area you are about to draw, [Okay] your selections. Select the Area tool and begin by choosing the first point of your area. Continue picking the outer boundary of the area until you have completed the Area. End your Area definition by choosing Close Path from the right-mouse pop-up menu.

Area Convert: This option found under the Modify Menu was created to help clean-up imported files. Some programs draw lines and rectangles as Area fills. The Area Convert option will analyze the file and convert thin areas to Line components and rectangular areas to Box Components. Just click the [Process] button.
Electronic Field Tools

Both Add Field and AutoField tools allow you to add new electronic form fields to your form. The Add Field tool creates a field with the location and dimensions defined by your two picks. The AutoField tool picks up the size attributes defined by its dialog box and determined location method, gutters and position of the field. Every time the AutoField tool is selected the dialog box will appear allowing you to set the location method, gutters and field dimensions prior to drawing. [Okay] and you are ready to draw fields.

The third tool is the Field Properties tool. This tool controls the properties of the field input prior to drawing it. Many times it is helpful to determine the properties before drawing the field, although it is not necessary, since the Field Properties dialog box will appear each time a field is drawn. For more information on Field Properties, see Creating E-Forms and I-Forms.

Measure

The Measure tool measures the distance between two picks on a page. It displays the X Difference, Y Difference, Distance, and Angle in selected units.
CHAPTER 5

Understanding Your Fonts

Understanding fonts can be difficult. When should you use PostScript and when to use TrueType? Depending on your selection, there can be many adverse effects. Understanding the fonts and how they work can virtually eliminate any problems.

TrueType Fonts are great for forms being distributed as Visual Basic E-Forms or for the HTML I-Form which uses the browser’s Windows Print option and the standard Arial and Times Roman fonts. OneForm’s font default is TrueType Arial.

But for Paper Forms, the rule of thumb is to use PostScript fonts when designing files for use with any of the following OneForm Designer Plus options:

- Typeset Output Option
- Stationery Option
- PDF Generator Module

Requirements

The fonts must be installed into Windows before OneForm Designer Plus can find them. The requirements are different according to operating system and type of font.

*PostScript:* Windows 2000 and XP can recognize PostScript fonts. Use the method found under Control Panel, Fonts to install the required Adobe Type Basic Font Library. (If you are still on a Windows 98 or Windows NT, OneForm Designer Plus requires the use of Adobe Type Manager. Also, the Adobe Type Basic Font Library is necessary.)

*TrueType:* On a Windows 2000 or XP use Control Panel, Fonts to install the fonts.

Once the fonts have been installed, they will appear in the OneForm Designer Plus Font Setup list for their respective type: PostScript or TrueType.

If you need more information, the basic concepts that are important for setting up and using fonts are found in this chapter. The topics include:

- Installing the Fonts on a Windows 2000
- Why Font Mnemonics Need to be Established
- Setting Up Fonts in OneForm Designer Plus
- Fonts Supplied with OneForm Designer Plus
- Winfonts1.ini File
- Matching MECCA System Fonts to OneForm Designer Plus
- Details on the Differences Between PostScript and TrueType Fonts
Installing the Fonts on a Windows 2000

1. Start, Settings, Control Panel, Fonts.
2. The Install New Fonts option is found under the File menu.
3. Choose Browse and locate the directory source of the new fonts.
4. Select all of the fonts from the Source list.
5. Check on the option “copy fonts to Font folder”.
6. Click [OK] to start the install font process.

Why Font Mnemonics Need to be Established

OFDP requires that you assign a unique font mnemonic (2 to 5 characters) for each font that will be used, so decide what you are going to use as font mnemonics. The OneForm software recognizes fonts by their assigned mnemonic and not by their Font Name. OneForm Designer also has a requirement that one of the fonts be assigned a *ge* font mnemonic. It is usually reserved for one of the following: TrueType Arial or PostScript Helvetica.

![Figure 5-1: OneForm Software Recognizes Fonts by Assigned Mnemonics](image)

Since OneForm Designer Plus references fonts through font mnemonics, it will always use the first font found with that mnemonic when searching through the list. PostScript fonts are always read first by the software, this causes the PostScript version to be used when font mnemonics are the same for both PostScript and TrueType. This can be avoided completely by making sure that the font mnemonics are not duplicated. For example, you could name the PostScript Times (ti) and the TrueType New Times Roman (titt).
Setting Up Fonts In OneForm Plus

The OneForm Font Setup option updates the Text Tool’s font selection list and insures an accurate font display and output within the OneForm Plus software.

Within File, Font Setup, there are two setup options: Postscript Font Setup and TrueType Font Setup. If you plan on using both font types, you must setup both.

Let’s look at the TrueType Font Setup. The following dialog will appear listing all TrueType fonts available. Sorting by Font Mnemonic will bring all fonts without a mnemonic to the top of the list. Those you want to use will need to have unique font mnemonics assigned.

Do this by highlighting the font and filling in a font mnemonic and style choice. You will see it update as you select [Modify Font]. Fonts are seen as families. The program will try to locate all associated styles within the family and assign the proper style mnemonics. It will not let you reference fonts it sees as different families with the same font mnemonic, without checking Allow Mnemonic with Multiple Families first.

Click on [OK] to save the changes. You must Exit out of OneForm Designer Plus and restart for it to see the newly setup fonts.

Figure 5-2: Font Setup Dialog Box

Selecting [Add Default Fontcodes] will assign mnemonics to all fonts known using Amgraf’s defaults.

The Font Mapping dialogs update a configuration file: winfonts1.ini.

Chapter 5: Understanding Your Fonts
Note 1: For True Type fonts to be seen in the Text Tool’s font list, the Fonts Setup, Allow True Type Fonts option must be checked. Also, you must Exit out of OneForm Designer Plus and restart for it to see any newly setup fonts in the Text Tool’s list.

Note 2: If a True Type Font is given the same mnemonic as a PostScript Font, the PostScript will be used instead. It is best not to use duplicates.

Fonts Supplied with OneForm Designer Plus

FontBank Library: There is a library of 330 fonts which include a wide variety of serif and san-serif faces along with a large selection of script, creative display, and calligraphy faces.

These fonts are supplied both as PostScript and TrueType. They can be found in the OneForm directory under FontBankPS and FontBankTT. These fonts must be installed as any other. The font mnemonics can be assigned automatically by choosing [Add Default Fontcodes] during OneForm’s Font Setup.

Barcode Fonts: The Draw Barcode option requires installation of the Amgraf Barcode PostScript Font Library. They can be found in the OneForm directory under BarcodePS. These fonts must be installed as any other. The font mnemonics must be assigned automatically by choosing [Add Default Fontcodes] during OneForm’s Font Setup.

Winfonts1.ini File

The winfonts1.ini file is an important configuration file that contains all of the fonts that have been setup through the OneForm Designer Plus Font Setup.

When selecting a Font, the software looks at the winfonts1.ini file, searches for the mnemonic and then displays the first font with that mnemonic. PostScript Fonts are always displayed at the top of the file. This implies that if you have two fonts with the same mnemonic, one PostScript and one TrueType, the PostScript font will always be used. To avoid this altogether, do not use duplicate mnemonics.

Winfonts1.ini is an ASCII file. The PostScript font string is different than TrueType. PostScript begins with the mnemonic first. This is generally 2-5 characters. It is followed by the Font style. For example ‘n’ would represent normal while ‘b’ would be bold. The Font family and name are next, followed by the location of where the font’s .PFB file resides on your system. This is one of two of the files needed for PostScript Fonts. The .PFB file contains the outline of the font while the other file, the .PFM, carries the metrics and screen display.
Matching MECCA System Fonts to OneForm Designer Plus Fonts

It is necessary to convert the MECCA System laser.sub font list to insure the font mnemonic/style selections for fonts are the same on OneForm Designer Plus as are on the MECCA Systems. A mismatch can cause fonts not to be found on OneForm Designer Plus when loading in existing MECCA graphic files.

1. Install PostScript Fonts onto computer. You will need the .pfb and .pfm for each font.

2. Locate the existing MECCA System laser.sub file. (On MECCA III it is usually in the \usr \bin \amgraf \PostScript directory. For MECCA 2000 it is in the \usr \mecca \fonts \fontinfo directory.) Copy the laser.sub file to the Windows computer and place in the \OneForm \fonts \fontinfo directory.

3. Start up OneForm Designer Plus and access Font Setup option under the File menu. Choose PostScript Font Setup. This dialog will list all fonts which are seen. For those fonts which have already been mapped to the winfonts1.ini, the font mnemonics and styles will be shown.

4. Go to the section for MECCA III laser.sub font path and [Merge] in the laser.sub file which you copied to the fontinfo directory. This will assign
Getting Started

the font mnemonic/style to the new fonts listed in the font setup menu instead of you having to physically choose each one.

5. [Okay] the Font Setup. This will update the winfonts1.ini file with the same font mnemonics as are on the MECCA Systems for a smooth transition. Exit out of OneForm Designer Plus and restart.

Differences Between PostScript and TrueType

PostScript and TrueType fonts are two widely used font types. Both are multi-platform outline fonts which can be scaled to almost unlimited sizes. But there are still differences between the fonts which make them not as interchangeable as they seem.

Originally, PostScript was adopted for use in high-end imagesetting devices, while TrueType was adopted by Windows and Mac for display and low-resolution printing. TrueType is built into most PCs, while PostScript is supported directly by most high-end output devices and must be installed onto the PCs separately. In laymen’s terms, the accepted rule has been, if printing to high-end devices, use PostScript. If the importance is on screen display for multimedia production, the Internet, or use for low-resolution printers, use TrueType fonts.

The first issue is sending out to PostScript devices, especially imagesetters. Imagesetters have problems either with TrueType fonts in general or mixing TrueType fonts with PostScript on the same page. Mixing fonts on the same page is usually not a problem for low resolution devices, unless there are fonts with identical names which can confuse the system as to whether you want PostScript or TrueType.

OneForm Designer Plus references fonts through font mnemonics and will always use the first font found with that mnemonic when searching through the list. Since PostScript fonts are always listed first in the winfonts1.ini file, this causes the PostScript version to be used when font mnemonics are the same for both PostScript and TrueType. This can be avoided completely by making sure that the font mnemonics are not duplicated.

When outputting through Windows print, your Windows printer configurations will control the font printed and any font substitutions. These settings vary among operating systems and printer devices. Ensuring that the same font is actually output can be guaranteed by changing the printer setting in the printer control panel. These settings vary per output device so be sure to check all devices for their settings.

Without getting too technical, there are three major differences between PostScript and TrueType fonts; the mathematical equations that define the shape of the font, the way in which fonts deal with scaling and interpreting fonts (hinting), and how devices handle the font. In a nutshell, PostScript and TrueType are different. What does this mean to you? Well, conversions between the two fonts will most likely vary the look of the file.
The second issue is display. Because TrueType is built into PCs, it is best to use common TrueType fonts when creating Electronic forms or HTML I-Forms. TrueType fonts are automatically supported by Windows and Mac systems, where PostScript fonts require special downloads.

**Printing and PostScript Fonts**

PostScript Fonts consist of two files, a .PFB and a .PFM. The .PFB file holds the outline information while the .PFM carries the metrics. OneForm’s Typeset Output option only prints PostScript fonts.

Windows Print option, however, is dependent on the individual print drivers and how they deal with fonts. It will be necessary to view their properties to ensure the PostScript outline is being printed rather than the font being substituted by a TrueType Font. To view the properties of your print drivers, go to the Control Panel and view the printers there. Under the File menu is a Properties option. Here, you may specify which fonts are outlined and which are substituted.

A special note about substitutions. For example, if a file has a PostScript font which is not resident on the computer, it will be substituted to Helvetica. If the form is then printed through Windows, depending on the individual printer, the font may again be substituted to Arial.

**Printing and TrueType Fonts**

TrueType fonts have all of their data in one file (.TTF), and have become a standard font choice for both Windows and Macs. As a result, we suggest that you use common TrueType fonts when working on Electronic Forms and HTML I-Forms.

When printing to a low resolution printer and through the Windows print, TrueType will most likely give you the correct font. Windows print uses Windows defaults. If the computer does not have the Font resident on the computer, OneForm Designer will substitute Arial for the font. Also, consider that each print driver has its own properties. Again, to guarantee the correct font output, edit the printer settings in the control panel to ensure the TrueType fonts are being used.
CHAPTER 6

Testing OneForm Designer Plus Installation for Visual Basic E-Forms

After installation of OneForm Designer Plus is complete and you have installed the Professional Edition of Visual Basic, test your software. Do this by running through the steps of generating an electronic form to see if your software is working correctly and can work with Visual Basic successfully.

Open the Accounting Form

Use the accounting electronic form found in OneForm’s Forms Library. Below is the full path of the Accounting Form directory.

Complete Path is:

C:\Program Files\Amgraf\OneForm\Forms_Lib\accounting\account01

The account01.elf file is ready to be generated. It contains fillable electronic form fields.

Figure 6-1: The Account1.elf Form
**Getting Started**

**Use GenForm to Generate and Start the E-Form**

OneForm’s **Generate EForm** option creates Visual Basic commands for displaying and using the electronic form and its fields. Just select the **Option** menu, **EForm/IForm Options** and **Generate EForm/IForm** to generate code. Choose **Electronic Form - Visual Basic** as the code to generate from the drop-down list. Next, check **Run E-Form** and select [Okay]. At the "Run Form Now" prompt, click [Yes].

![Figure 6-2: Generate Electronic Form Visual Basic Commands](image)

Generate EForm will generate all of the pieces necessary to create an electronic form. It creates source files for Visual Basic commands. At the same time it will start Visual Basic and the electronic form for simulation and testing.
The Electronic Form will appear:

![Electronic Form Diagram](image)

**Figure 6-3: The Electronic Form.**

**Using the Electronic Form**

Click on any field with the mouse, or use the Tab Key to move through the input fields easily.

**Field Color Identifiers**

The fields on the form will display in one of four colors. Each color represents a property assigned to the field. The four field colors and properties are as follows:

- **Green** - Identifies where the cursor is located.
- **Yellow** - Identifies that the field is required to be filled-in before the file can be saved. An error message will appear if the user tries to save without having input something into all of the required fields. The message will indicate which fields are left blank.
- **Gray** - Optional fields.
- **White** - Read-only and cannot be edited by the operator.
Getting Started

Notice that the form now has a menu bar and buttons. This is an automatic feature when generating E-Forms.

The Menu Bar for Electronic forms is similar to most Windows Menu bars it holds options that control viewing, printing, saving, and opening.

After testing the form, you can exit both the E-form and Visual Basic the same way, through the File menu Exit, or by clicking on the close button in the top right-hand corner.

When you exit the form, it will take you to Visual Basic. Then exiting VB will take you back to OneForm Designer Plus and the acount1.elf file.

This simple little test shows that OneForm and Visual Basic are both installed successfully and that your system is ready to create your own custom electronic forms.
CHAPTER 7
Testing OneForm Designer Installation for HTML I-Forms

After installation of OneForm Designer Plus is complete, check to see if you have Microsoft Internet Explorer 5.5 or higher. If that is the case, you are ready to test your software. Do this by running through the steps of generating an HTML I-Form.

Open the Accounting Form
Use the accounting electronic form found in OneForm’s Forms Library. Below is the full path of the Accounting Form directory.

Complete Path is:
C:\Program Files\Amgraf\OneForm\Forms_Lib\accounting\account02

The account02.elf file is ready to be generated. It contains fillable electronic form fields.

Figure 7-1: The Acount2.elf Form
Use GenForm to Generate and Start the I-Form

OneForm’s Generate IForm option creates an HTML file ready for testing the I-Form and its fields. Just select the Option menu, EForm/IForm Options and Generate EForm/IForm to generate code. Choose Internet Form - HTML from the drop-down list as the code to generate. Check Run I-Form and select [Okay].

Generate IForm will create an HTML file in the base directory. Checking the Run I-Form option will automatically start Microsoft Internet Explorer and open the HTML file for simulation and testing. Tab through the form and test field input. Closing Internet Explorer will take you back to the OneForm file.

NOTE

Refer to Chapter 14: Creating I-Forms in the Creating E-Forms and I-Forms Manual for complete details on generating .cgi scripts.
Field Color Identifiers

The Internet Form will appear:

![Image of Internet Form]

Figure 7-3: The Internet Form

Using the Internet Form

Click on any field with the mouse, or use the Tab Key to move through the input fields easily.

Field Color Identifiers

The fields on the form will display in one of four colors. Each color represents a property assigned to the field. The four field colors and properties are as follows:

- **Green** - Identifies where the cursor is located.
- **Yellow** - Identifies that the field is required to be filled-in before the file can be saved. An error message will appear if the user tries to save without having input something into all of the required fields. The message will indicate which fields are left blank.
- **Gray** - Optional fields.
- **White** - Read-only and cannot be edited by the operator.

This simple little test shows that OneForm is installed successfully and that your system is ready to create your own custom Internet forms.
**Printing the HTML I-Form**

When you are printing the I-Form, you will be using the browser’s Windows Print option. The browser’s defaults may not give you the best results.

Following are some hints:

Many of the OneForm Designer Plus components are using Windows “Print Background” option to print. To turn this on in your browser go to: Tools, Internet Options, Advanced Tab, Printing Choices, and toggle on *Print background colors and images*.

The browser’s Print, Page Setup usually has large page margins, along with headers and footers. This interferes with printing a form that has been designed full page. Modify the Page Setup dialog to reduce the margins and you can even take out the header and footer strings prior to printing.

If your I-Form is not printing centered, OneForm Designer Plus has a control for centering. Before generating, you can toggle the form to center itself on the paper. This is the Form Preferences, Global option *Generate with Centered Printing*. The default is to print forms in the upper left corner of the page.
INDEX

Add Default Fontcodes 64
Add Logo 30, 40
Adding Fonts into Windows 62
Adding Fonts into OneForm 63
Adobe Type Basics Library 3, 61
Adobe Type Manager 3, 61
Appendix A 3
Area 39
Attributes Dialog Box 58
Auto Save 16
AutoField Tool 59
Barcode Fonts 64
Box 38
Altering Boxes 43
Attributes Dialog Box 56
Check Spelling 53
Circle 38
Component Snap 49
Copy 44, 49, 50
Copy Others 45
Repeat Copy 45
Step Count 45
Creating a New Form Tool 34
Cut 50
Date Initialized 35
Documentation 3
Drawing Tools 13, 38
Area 39
Box 38
Circle 38
Line 38
Rectangle 39
Spline 39
E-Form Testing 69
Eight Direction Lock 49
Electronic Field Tools 59
Add AutoField Tool 59
Add Field Tool 59
Field Properties 59
Electronic Form Files (.elf) 11, 36
Features of OneForm Designer Plus 2
Field Properties 59
Field Tool 59
File Function Tools 34
File Name 35
File Types 11, 35, 36
Fit Screen 50
Font Setup 6, 61, 63
Adobe Type Manager 6, 61
OneForm Plus 6, 63
PostScript 6, 61, 66, 67
TrueType 6, 61, 66, 67
Fonts
Barcode 64
FontBank 64
Font Mneumonic 62
PostScript 6, 61, 66, 67
TrueType 6, 61, 66, 67
Understanding Fonts 61
Form Library 3, 17
Form Templates 35
Form Type 35
Form Width/Depth 35
Form X/Y Origin 35
Forum, User 5
Generate E-Form 70
Generate I-Form 74
Graduation
Angle 58
Progression 58
Type 58
Graphic Files (.g) 11, 36
Grid Snap 49
Hint Bar 10
I-Form Testing 73
Imagesetters 66, 67
Input Text 38
Installation 1, 4
Interactive Text 13
Job Number 35
Laser.sub 65
Layer/Color 57
Level to a Position 47
Line 43
Altering Lines 43
Attributes Dialog Box 55
Logo 40
Measure 59

Index 77
Getting Started

MECCA laser.sub 65
Menu Bar 10
Merge laser.sub 65
Microsoft Internet Explorer 3
Modify Drawing Tools 38
Modify Properties 14
   Existing Boxes 43
   Existing Lines 43
   Select Cursor 42
Move Tool 44, 45
   Bring Others 45
   Horizontal Only 45
   Repeat Last Move 45
   Vertical Only 45
New File 11, 34
OneForm’s Profile Menu 8
Open Tool 34
Opening a New File 11
Opening an Existing File 18, 36
Operator ID 35
Overview 1
Paste 50
Plumb to a Position 51
Pop-Up Menus 14
PostScript Font Setup 6, 61, 66, 67
Print 32, 34, 37, 76
Process Color 35
Properties
   Modify 14
   Set Line, Box and Area 55
   Using the Select Cursor 42
Quitting 16
Rectangle 39
Registering Your Product 5
Rotate 48
   Copy Count 49
   Key in Angle 49
   Make Copy 49
   Pick Center 48
   Repeat Rotate 49
   Rotate Others 49
Save 15, 16, 34, 37
Save As 16, 37
Scale 48
   Key in Size 48
   Pick Center 48
   Repeat Scale 48
   Scale Others 48
Scr[...]
Menu Bar 10
Merge laser.sub 65
Microsoft Internet Explorer 3
Modify Drawing Tools 38
Modify Properties 14
   Existing Boxes 43
   Existing Lines 43
   Select Cursor 42
Move Tool 44, 45
   Bring Others 45
   Horizontal Only 45
   Repeat Last Move 45
   Vertical Only 45
New File 11, 34
OneForm’s Profile Menu 8
Open Tool 34
Opening a New File 11
Opening an Existing File 18, 36
Operator ID 35
Overview 1
Paste 50
Plumb to a Position 51
Pop-Up Menus 14
PostScript Font Setup 6, 61, 66, 67
Print 32, 34, 37, 76
Process Color 35
Properties
   Modify 14
   Set Line, Box and Area 55
   Using the Select Cursor 42
Quitting 16
Rectangle 39
Registering Your Product 5
Rotate 48
   Copy Count 49
   Key in Angle 49
   Make Copy 49
   Pick Center 48
   Repeat Rotate 49
   Rotate Others 49
Save 15, 16, 34, 37
Save As 16, 37
Scale 48
   Key in Size 48
   Pick Center 48
   Repeat Scale 48
   Scale Others 48
Screens (Areas)
   Graduation Angle 58
   Graduation Progression 58
   Graduation Type 58
Screen Angle 58
Screen Lineage 57
Screen Type 57
Select Cursor 42
Setting Up Fonts In OneForm Plus 63
Spelling Check Tool 53
Spline 39
Spot Color 35
Starting OneForm Designer Plus 9
System Requirements 3
Text 51
   Attributes Readout 53
   CompMode 52
   Editor 13, 53
   Font Tab 51
   Horizontal Size 52
   Input Text Tool 38
   Interactive 13
   Leading 52
   Left Margin 52
   Name 52
   Properties 51
   Right Margin 52
   Vertical Size 52
Title Bar 10
Tool Bar 10, 34
TrueType Fonts 6, 61, 66, 67
Typeset Output 6, 37
Understanding Your Fonts 61
Undo 49
User Forum 5
View 50
Visual Basic 3, 70
Window - Main 10
Windows NT 3, 54
Winfonts.ini File 7, 64
Zoom Tools 50
   Area 50
   Down 50
   Up 50